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Edit Mode Interface

® Photos has simple tools that can
improve you photos and videos
without a lot of work. Look to the
top right corner of the Tool Bar, in

the Standard Photos View.

® There is the Auto Enhanced button
and the Rotation button.
® Other than that, one has to go into

the Edit Mode, to do any editing at
all.

¢ Click on Edit, extreme right in the
Tool Bar.




Edit Mode

* \When in the edit mode,
the entire Photos interface

changes.

* Everything changes into a ©6 B0 Reverto Origina
Dark Mode.

* Three different sets of
editing tools T -

* Top-left of Tool bar: A
zoom slider, show original,
and Revert to original.

* Adjust, Filters, and Crop.
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® |In the Histogram, the lines are
straight up and down.
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®* Notice the lines in the Histogram
have moved - slightly.
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Crop & Straighten

Crab corner adjustments - click and
drag to crop.

Click and drag image around frame.
Click and drag from each side.
Choose aspect ration before crop.
Choose orientation.

Then crop. Will keep proportion.

Top -right of sidebar- angle adjustment.
Straighten, vertical, horizontal.
Flip button

Reset button - Will undo crop and
straighten adjustments only.




Filters

Access the Filters tab on the Tool
Bar.

Choice of 9 filters on the sidebar.
Filters come in three variations on
three concepts:

Black & white

Dramatic

Vivid.

You can undo filters once you are
back in the Library.
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Introduction to
Adjustments

Tap the Adjust tab in the middle of the Tool
Bar and all your adjustment will show up
on the Sidebar.

To expand the files, click on the down
arrow in each section.

From the View menu, you can choose to
show the Histogram. The left edge of the
Histogram darkens the image. The right of
the Histogram shows the brightness part
of the image.

The Histogram can be your major
adjustment guide for your editing.




Light Adjustment

* Image too bright or too dark?
* Photos offers seven different S —— .. o
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adjustment settings dedicated to e o RS .
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Color

* Color is difficult. The camera isn't
as good to seeing color as the
human eye.

* Might be easier to just click the
Auto button.

* \Vibrance is better to use than
satuation. It is more subtle.
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Edit Mode Interface

® Photos has simple tools that can
improve you photos and videos
without a lot of work. Look to the
top right corner of the Tool Bar, in

the Standard Photos View.

® There is the Auto Enhanced button
and the Rotation button.
® Other than that, one has to go into

the Edit Mode, to do any editing at
all.

¢ Click on Edit, extreme right in the
Tool Bar.
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Edit Mode

e When in the edit mode, the
entire Photos interface

changes.
* Everything changes into a

Dark Mode.

* Three different sets of
editing tools

* Top-left of Tool bar: A
zoom slider, show original,
and Revert to original.

* Adjust, Filters, and Crop.

® I’C] Revert to Original

Adjust Filters
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Crop S Straighten

Crab corner adjustments - click and drag
to crop.

Click and drag image around frame.
Click and drag from each side.

Choose aspect ration before crop.
Choose orientation.

Then crop. Will keep proportion.

Top -right of sidebar- angle adjustment.
Straighten, vertical, horizontal.

Flip button

Reset button - Will undo crop and
straighten adjustments only.
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Filters

Access the Filters tab on the Tool
Bar.

Choice of 9 filters on the sidebar.
Filters come in three variations on
three concepts:

Black & white

Dramatic

Vivid.

You can undo filters once you are
back in the Library.
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Introduction to
Adjustments

Tap the Adjust tab in the middle of the Tool
Bar and all your adjustment will show up on
the Sidebar.

To expand the files, click on the down
arrow in each section.

From the View menu, you can choose to
show the Histogram. The left edge of the
Histogram darkens the image. The right of
the Histogram shows the brightness part
of the image.

The Histogram can be your major
adjustment guide for your editing.
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Light Adjustment

* Image too bright or too dark?
®* Photos offers seven different S —— .. o
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Color

* Color is difficult. The camera isn't
as good to seeing color as the
human eye.

* Might be easier to just click the
Auto button.

* \Vibrance is better to use than
satuation. It is more subtle.
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* Cast - color correction - blue to the left and yellow to the right.
®* Cast - color correction - blue to the left and yellow to the right.
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Black and White

* Only available in macOS, the Black
and White adjustments.
* You have 4 adjustments.
* Intensity: increases & decreases
tones.
* Neutrals: Lightens or darkens the
gray areas of the photo.
* Tone: Adjusts the photo for a more
high-contrast or low contrast look.
* Grain: adjusts the amount of film
grain (if any) that appears in the
Photo.
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Retouch Tool

® The retouching tool, accessible in
Adjust mode on a Mac by clicking
the disclosure arrow to the left of
the Retouch section and then
clicking the paint brush icon, is a
simple brush tool that lets you
remove dust, wrinkles, blemishes,
and other unwanted junk from
images.

* |t takes practice.

® Zoom in as much as you can on the
section you are working on.
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Red Eye Tool

® Red eye Tool can be done
manually or click the Auto button
and it should correct itsellf.

® Just make sure the circle over the

eye fits closely.
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White Balance

® What Balance resets the color
temperature that is defined as “White” in
a particular image.

® On a Mac, you can use White Balance
adjustment select something you see in
your image that’’s’ white, neutral gray, or
even skin tone.Photos uses this as a cue
to adjust the color temperature of the
entire photo.

® This simple adjustment can provide a
natural appearance to all sorts of images.
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L.evels

The Levels adjustment gives us a fine
tune adjustments over an image.
Start with using RGB, and adjust the
levels from Histogram.

There are 4 main control points on the
Histogram. Black Point —Shadows—
Midtones —White Point.

Rule of Thumb — Start with Black Point
and White Point and move toward the
middle until the Histogram starts to
move up.

Moving the Levels with RGB or Red, or
Green, or Blue, depend on the colors
your image.
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Curves

® Curves work the same way Levels T P S e s
does, but on a different Interface. | ‘
¢ Available only on a macOS, this

P Black & Vihite

¥ Rerouch

adjustment, along with Levels are il R 80 LR AR .

) Z White Gaanca

= Curves

classic controls you might B s om0 =
remember on Adobe Photoshop. e e e R
* Use them to adjust Tonal range, cadiic., S0 TR T COIE
contrast and color of a photo by (= e N

Daf ritlon

s Selective Color

specific color ranges, or even shift L e R
a specific color.
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Definition

®* The definition adjustment can add
shape and contour to your images
by bringing out more definition in
the medtones and adding BN e B g P
contrast. S i T A

* You will notice more visible '
texture in your image.

12 Dalance

Resed Mijeslmenls
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Selective Color

® This is a powerful tool in Photos.

® There are 6 colors to choose from.

¢ Using the eyedropper, you can
pinpoint the color you want to
enhance.

® Select a color - then use the
sliders (Hue,Enhance, Satuation)
to adjust an overall color in the
image. The Range slider adjusts
the intensity.
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Noise Reduction

® Sometimes images, especially
those taken in low light, can be
noisy - full of little specks, that are
a side effect of allowing the
sensor to receive more light, in
order to get a better shot.

® Adjust the Noise Reduction
setting to smooth out some of the
hoise in the image - it may cut the
sharpness a little bit.

* | didn't have a RAW image to show
you, but you should get better
results with a RAW image.
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Sharpen

® The Sharpening adjustment has
three slides - Intensity - Edges -
Fallout.

® The Intensity slider will adjust the
strength of the sharpened edges.

®* Edges slider will adjust how many
pixels are included on the edges.
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Vignette

®* This adjustment adds an old-
school vignetting effect,
darkening the edges of the image.

®* By using the Vignette, you can
bring more attention to the
subject n the middle.

® Vignettes might look better in
black and white.
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Live Photos

Live Photos can be taken on a iPhone or
iIPad.

The image is a full resolution photo with @
3 second video.

Live Photos have their own media section
In the sidebar.

View your live photos by clicking on the
icon in the upper left corner.

You can shorten the video part by
dragging the Fram closer to the middle.
You can turn off sound but not volume.
You can make a Key Photo.

Menu on bottom right, gives you a choice
on how you want to present the photo:

* Live - bounce-loop-long expose .
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Portrait

® The latest iPhone and iPad
devices have software that
detects the foreground and
background of images and can
apply effects to one or both.

¢ After you click on edit — Portrait
controls appear.

¢ Adjustments for “Portrait” on right
side of screen, give you the depth.

¢ Adjustments on the bottom of the
edit screen gives you effects.
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Edit with Extensions

e With Extensions, we can use third
party editing applications,
without leaving the Photos
Interface.

* Photos extensions are managed
from the Extensions System Pane.
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Lxtensions App Store

® You can access the App Store
from the adjustments pane in the
Potos Interface.
® (Red Box
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Photos for macOS comes with a suite of editing tools, but these extensions expand your
options. Apply edits from multiple apps without the hassle of launching and switching
among different windows.
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& Affinity Develop

& Affinity Haze Removal
@ Affinity Liquify
& Affinity Miniature

£ Affinity Monochrome
& Affinity Retouch
# Editin Acorn
& Edit in Affinity Photo
&Y Edit with GraphicConverter 11
& GraphicConverter 11 Xe8472
" Luminar 4
Markup
03 Pixelmator Pro

& App Store...
) Manage...
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Edit Videos

The capabilities of the Photos Interface no way
stands up to a full blown video editing
program like iMovie or Final Cut Pro.

But, it can be used to apply Sidebar color
adjustments. Crop and trim videos.

The adjustments make from the Sidebar, will
be applied to all the clip through out. What
looks good in one scene, may not look that
good in another.

At the bottom of the video you have, Timeline,
Plate Head, Trim Handles.

You can Mute or unmute the audio in the
video.
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Save Video

® Click Done and have the option to
save the video, which will rewrite
the original, or just save the new
clip and retain the original.

clip to include only the trimmed section.

Save Video

Save Video

Save Video as New Clip

Cancel
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Make Poster Fram

® Open up in Edit again and run the
Plate Head down the Timeline to
pick the frame you want as an
icon for the clip.

® Go up to the Menu Bar and choose
“Make Poster Frame”

® Return to Library.
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